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Well, dear readers, this is our first anniversary issue, number 12. It'sa milestone that makes me very proud to have been part of thisproject. But I didn't do it alone. There are a lot of great people"behind the scenes" that work all month to make this magazinepossible. Over that past year we've gained some and lost some, butthe project continues -- as it should.
Might I suggest that you take a moment to read through the list ofcontributors, graphics artists, editors, proofreaders, coders, etc?Then visit the main forum and PM someone from that list and tellthem how much you appreciate their hard work.
And it IS hard. We spend a lot of time scouring the main forum andother sources for article material. Then someone writes the articleand the proof/edit process starts. It takes two weeks of emailingarticles around the world (literally - we are spread from China to USA,to England, to Australia), to get them in clear, readable language thatanyone, new to Linux or old timer, can read and enjoy.
Then the articles are sent to layout and prepared visually. That, ofcourse, includes the great covers we've brought you each month.Each one is a creation by our graphic staff, not just some free clip artwe grabbed somewhere.
And this month we continue the tradition with thirteen articles on awide range of topics, including our ongoing KDE User Guide.

Tim Robinson
---
Starting with the September Issue, Papawoob will take over as Editorin Chief. Because of health problems, I am stepping down from thatposition. I'll stay on as an editor and occasional writer. It has been agreat year and I've learned a lot and developed some strongfriendships. I'll still be here, and readers should feel free to email meas previously, but Papawoob will handle the "Letters to the Editor" infuture.

From the Chief Editor's Desk
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PCLinuxOS 2007 FINAL Released

Written by Texstar, Sunday, 20 May 2007
Texstar and the Ripper Gang are pleased to
announce the final release of PCLinuxOS 2007.
Featuring kernel 2.6.18.8, KDE 3.5.6, Open
Office 2.2.0, Firefox 2.0.0.3, Thunderbird 2.0,
Frostwire, Ktorrent, Amarok, Flash, Java JRE, Beryl
3D and much much more. Almost 2 gigs of software
compressed on a single self bootable livecd that can be
installed to your hard drive provided it is compatible with your
system and you like the distribution. Over 5000+ additional
packages available after hard drive install through our Synaptic
Software Manager. Please note PCLinuxOS does not ship with
Win32codes or DVD decryption software. Proprietary Nvidia and
ATI drivers available after hard drive install.
In addition we'd like to give out a special thanks to the
PCLinuxOS community who stepped up last month to help us
out and kept us going. Thank you for all your support and we'll
keep working hard to bring you a good Linux distribution you
can be proud of. We also want to thank Enki Consulting for
providing hosting for our website and ibiblio.org for hosting
our distribution.

http://www.enkiconsulting.net/welcome/landing-pages/growing-company.html
http://www.pclinuxos.com


by Merlin Whitewolf
Recently, my son and his family moved. They had bought a houseand were moving into it as first time home owners. I offered to helpand made the drive there to give what assistance I could. Mydaughter-in-law assigned me the job of “designated babysitter” andrefused to allow me to do any heavy lifting. She's a very wise woman.
To be a babysitter means that you must watch out for and take careof children, but it often turns out that they're doing as much for youas you do for them. That was the case for me when I decided to havemy granddaughters, ages 10, 8 and 5, learn to use Gimp as a way toentertain them during the move. I have no delusions as to the skillwith which I can create graphics. I know next to nothing of thismarvelous skill, but I chose to use this as more in keeping withcatching the interest of the young.
The 8 year old granddaughter started off. That is, on the morning westarted this, she was the first out of bed after me. When her sistersawakened, she was almost done with the wallpaper that she made.This is how things proceeded, as near as I am able to remember:
We opened Gimp and chose “New” and 1600 by 1200. Next shechose a color. I had thought that color choice would be a fairly simplething, but it isn't really so in every situation. When you're addingeffects to it, your color choice may need to be changed as the effectsyou're going for may alter the color in a way that you do not want. Oras she put it, “That makes the color different. We have to use anotherone.”
Choosing which effects and how to apply them was another lessonfor me. The way an effect behaves by default is not necessarily howyou want something to appear, so you look for and apply changesuntil you get what you want. The “undo” under the “edit” menu saw alot of use as first one color and then another and as first one effectand then another was chosen.
Finally she announced, “That's it, Popa. It is the best we can do.”
On the next page is the wallpaper she created:

Lessons From Children



After a long day of moving household items and of course, playing,my youngest granddaughter took her turn at graphics creation. At 5years old, she is an amazing artist. She was very decisive about whichcolors to choose and where and how they were to be used. The onlydifficulty she had was in having Gimp to show the color choices thatshe wanted. I learned a lot from her about making slight alterationsin the color choice menu to get just the right shade of color and theright amount of light or darkness to each color.
Her wallpaper was created in the shortest amount of time. In part,that may be that she had already seen how her sister had madechoices, but it is also that she has a natural ability to create art. Thatis my firm belief.
On the next page is the wallpaper that she created:

Lessons From Children



It has what might be termed a typical 5 year old's 'in-your-face' look,yes, but take a closer look at it. In the main field there are subtlesquares of light and dark. In the center there is an eye. The pupil ofthe eye is a striped egg of many colors. She created three levels ofartistic effects in one picture. Each could be taken to be a singlecreation, but she chose to combine them into one and thus made amore 'advanced' creation. I found this to be very impressive.
Last, but definitely not least was my oldest granddaughter. She tooklonger than the others to create her graphic. She chose first onecombination of color and effect and then another. The “undo”function was used more in her efforts than those of her sisters. Whensomething didn't work for her, she was ready to try another choice.She went through several effects choices for each color before shewould change to a different color.
It might be said that she had a hard time making up her mind. I thinkthat she was wanting to see how an option would look before shedecided if it was a keeper or not.

Lessons From Children
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This is the wallpaper that she created:

She took her time in choosing this exact shade of blue and the exactwidth of each turn of the spiral.
Stare at it for a moment. Do you get the sensation that a subtlemovement is going on? What else might you see there? Think on it. A10 year old chose to create this effect.
My granddaughters are eager for me to return for another visit. Imust bring my laptop, of course, as they want to create moregraphics. I wonder what they will create next?



Letters To The Editors

I have PCLinuxOS loaded on my 2GB memory stick so it loads fromthere on ANY PC! I just tried it on my basic laptop and found thatconfiguring the built-in Broadcom wireless card was a breeze. I hadpreviously put the Broadcom BCM43xx files in a folder on mywindoze partition which were accessible from root. Using the tools inPCLinuxOS I simply had to type in the WEP key for my wirelessmodem/router (a Netgear device) and hey presto! The blue wirelessLED came on and I am in touch with you. I just have to work out howto save the settings to my memory stick. Just wish a few more gameswere in the setup by default. Will try the 2007 version soon.
Morrison H

Thanks a lot for your feedback, Morrison. Try PCLinuxOS 2007 Final soon.
I'm sure you will be pleased with the changes and improvements that have
been made since previous versions.

Tim

Hello all,
As a relatively new Linux user (12 months), I have tried many distrosstarting with Ubuntu, and then went onto experiment with Fedora,Sabayon, Sam just to name a few. I came upon PCLinuxOS just byaccident and wow am I impressed. Whilst the 'community' is not asrobust as the Ubuntu community the product speaks for itself.
I keep other distros on my system but now rarely even go to them asPCLinuxOS does it all with gusto!
Thanks to all the developers for a great product!
Tony C

Tony, thanks for those kind words. I'm sure Texstar and the rest of the
developer appreciate hearing such praise.

Tim
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Great Magazine!!! I'm a Linux noob and found these articles VERYhelpful/informative. Keep them coming!
Steve B
Thanks, Steve - we will.

Tim

Hi,
I am an entirely 100% newbie to Linux and wish to both thank youand compliment you on a job well done. Having absolutely zeroexperience with Linux I am presently trying to go through that oh sopainful part of trying to figure out what Linux is all about. The partwhere you choose a distro to use to see if you can actually like Linuxand make it work. I've downloaded nearly 50 different distros in thelast couple days to burn to CD and then try at my leisure to see if I'mtotally stupid or can convert to Linux. PCLinux was the very last one Idownloaded.
While it was downloading I was also trying to make copies of anypertinent paperwork that might apply. Manuals, FAQs, etc, to makethings easier as I start out. In the process I came across the link tothe PCLinuxOS magazine for July 2007. Lord Bless you for all thewonderful information you included in that issue. I honestly can saythat after reading that one magazine I now know more about Linuxand how it operates than after nearly 3 months of seekinginformation online. And it was written in a manner that made it easyfor me to understand without making me feel like a total idiot orspeaking down to me.
In my mind, the single greatest sin of any computer user is that weforget that at one time or another each and every last one of us was a"NEWBIE" that was begging for help to understand this great newworld of computers. We look down or speak down to those newbieslike we are God and forget at one time they were us. In yourmagazine you do not do this and for that I cannot commend youenough. You also have achieved that wonderful ability to be able towrite articles that are both helpful to the new and the more wiser andknowledgeable Linux user at the same time. That ability is almost a
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God given gift that few of us ever are capable of. Cherish it. And keepright on using it to help those like myself learn about Linux and thegreat wonders it promises to come. Only good can come from wiseuse of that gift like you are doing now.
I was brought up on Microsoft Windows from the very first when DOScame out. It is like anything else. A learning experience. And whatyou learn is learned through years of effort in the computer world.Your magazine and the way it is written takes years off that learningcurve for so many and in so many ways I cannot begin to list themall. But this I can tell you. After reading this one copy of yourmagazine I probably have taken at least 2 years off my learning curveof being able to operate a Linux based computer. That is saying a lot.
It has been years since anything gave me that boyhood thrill to see orreceive. Your magazine is the first thing in so many years to do that Ican't even believe it. I actually sat here and read the entire magazinepage by page until I was totally finished. I didn't skip one detailanywhere in it. It was like one of those thriller books you get into as ayoung man or woman that grabs you and you can't sit it down untiltotally finished. And I can't wait to go back and download all the restof those available back copies you have on your site. I'll probably beup all night long reading your magazine from cover to cover in eachissue.
You not once tried to cram something down my throat the wayMicrosoft has begun doing to their customers. Not once did you tryto tell me in certain ways that I wasn't smart enough to know what Iwant or need on my own computer like so many of the Microsoftcrowd do nowadays. And don't get me wrong, I love Windows andhow it operates. Except for the security issues that is. And the priceof the software you really need. But those issues aside I really doenjoy Windows. However, when Microsoft began forcing people to goout and totally rebuild or replace their computers every three years itbegan to be to expensive to use Windows. When they began to forcepeople to change operating systems every three years it became toexpensive. And when they started forcing people to go out and buyall new software every three years to go with the new computer andthe new operating system because they made the new stuff refuse towork with any of your older software it became to expensive. VISTAbecame the last straw for me. It is nothing but eye candy for WindowsXP and yet they try to force me to replace all my Microsoft Office



applications at hundreds of dollars each to go with it. That was whenI knew I had to do something else.
And lo and behold there was Linux. I had tried it just as little asabout four years ago and could make absolutely no sense of it at allback then. Now Linux has progressed to the point where manydistros look and operate very similar to Windows. AND IT DOES ITFOR FREE. PCLinux seems to be one of those distros that does exactlythat. It appears at the onset to be one distro that will allow a newbielike myself to make that last jump from the Microsoft sinking ship.And I don't think I'll need a four year course at a college to be able todo it. Many Linux flavors today even have the new 3D GUI thatMicrosoft says can't be duplicated in any Windows operating systemexcept Vista.
So from the bottom of my heart I wish to thank all of you both atPCLinux and at the PCLinux OS Magazine for assisting me in beingable to finally learn and be able to use Linux at home in aconstructive manner. I, my wife, and my daughter all have our owndesktop computers. My daughter and I both have laptops also. Andon top of all that I have been trying to figure out how to afford to setup at least one if not two file servers to keep all our importantinformation on in a safe manner. Plus we have been interested insetting up a new media center edition of a computer for all ourshareable files and movies and music etc. The Microsoft cheapestserver software is hundreds of dollars per copy plus operatingsystems to go with each. Not to mention the individual computercopies of all the various software we use and need each day. Linuxcan basically save me literally thousands of dollars just maintainingmy own home computers.
Not to mention the horribly hard part of trying to teach my daughterand wife a completely new way to use computers without Windows.PCLinux appears to nearly take all that effort away overnight. And Idreaded that part the most. You have lifted a horribly heavy burdenoff my heart with PCLinux and your magazine. Even my daughter whois extremely ADHD and has tremendous times trying to learn newthings can understand your magazine. It explains things to her in away even she can understand and be able to make sense of againwithout making her feel like someone is talking down to her. Wecannot thank you enough for that.

Letters To The Editors
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I've taken up enough of your time and will let you go now. Justwanted you to know that what you do is good, that it succeeds whereso many others totally fail, and it is so clearly appreciated by so manyof us. Give yourself and your team one great big pat on the back.God Bless and thank each and every one of you.
Sincerely,
Allen W

Thanks for the kind words, Allan. All the staff work hard during the month
to provide articles that are fresh, informative, and in language that those
new to Linux, as well as "old-timers" can deal with. Be sure to check out
some of the back issues. I'm sure you will find more useful information
there as well.

Tim

First and Foremost Hello to all and congratulations on PCLinuxOS!
Here's a little background to my story. I live in Greece and I havebeen using Linux since 1997. I started with SuSE version 6.0 and hadkept updated my lowly PII all the way to version 10.2 of Open SuSE. Iwas not very happy when I upgraded to 10.2 and lost the ability touse arecord.
A small thing huh?
Anyway, this summer my son and I are visiting my parents in Spring,TX. I should also mention that my 17 yr old son is probably betterversed with Linux than I am. My parents asked me to take a look atmy mom's computer (PIII with 512MB). When she logged on to herWindows XP box she had to get up and leave for about 10 minuteswhile the silly thing connected to the Internet. I tried installing SuSE10.2 on the box but it just kept freezing at odd moments and theresponse of the computer was not really satisfactory. I then triedUbuntu but it could not configure the Riva 128 video card properly.So far Linux was 0 for 2.
While I was working on this, my dad was busy spoiling my son with a



new laptop. Since we don't have a decent LUG in our neck of thewoods in Greece we decided to take a trip to the Houston LUG andsee what kind of information they might have for us. While we werethere one of the users brought over a CD of PCLinuxOS final and Itried it on my son's new laptop. Impressive.
When I got home I installed it on my mom's box in less than 30minutes. I updated the box over night and viola! It works like achamp. No setup problems, no vim /etc/X11/xorg.conf, no vim/etc/fstab. It found the USB wheel mouse (SuSE didn't) and the USBflash drive that I had forgotten to remove was also set upautomatically. It even set up the rinky-dink HP multi-function ink jet.I really liked the touch with the NTP daemon. This distro is just great.
My parents were really impressed since they had been prepped by thewindows propaganda to buy a new computer. I am now teaching mymom how to use Open Office, Evolution and Firefox.
The only thing I have left to do is set up a backup job in cron and seeabout doing a little better job with filtering spam. I would beinterested in hearing how other users have set up their mailingsystems.
Well I think I have about used up my word count.
Thanks again,
Rod C

Thanks for the feedback, Rod. It's always great to hear about people's
success with our favorite Linux distro. When you return to Greece, why not
try to start a LUG there? Happy computing.

Tim

Letters To The Editors
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CHAPTER 7: MULTIMEDIA GRAPHICS ACCESS

Multimedia Access and Players

Apart from being able to view and create graphics and other images,the PC is capable of supporting a wide range of audio and videofeatures and facilities. These include the playing of audio CDs, audiodigital files, VCD and DVD as well as multimedia games.
Note:While support may be available in the software, the necessaryhardware has to be available before these multimedia facilities can beused, e.g. a DVD drive is required to be present on the system beforeyou can play a DVD.
By default most modern PCs come with a CD-ROM drive capable ofplaying audio CDs and VCDs as well as a sound card and speakers.

KDE User Guide, Chapter 7
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As such in this chapter we shall discuss how you can listen to anaudio CD, play audio digital files and view VCDs.
In the following sections we shall be discussing several mediaplayers. Some of these e.g. mplayer and xine are multimedia playersin that they can be used as generic players for audio CD, digital audiofiles, VCD and DVD.
THE VOLUME CONTROL APPLET

Since almost all the multimedia applications require some form ofaudio production and mixing, it is useful if we know how to controlthe various channels of audio available from the sound card using theVolume Control Applet on the Panel. This may be launched by right-clicking the Volume Control icon on the Panel and selecting OpenVolume Control. If it is not there you can also launch it form the MainMenu:
Main Menu -> Multimedia -> KMix

Fig. Volume Control Applet
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Kmix is essentially an audio mixer which enables you to mix theaudio for a 2-channel sound card. Every mixer control that yoursound card provides is represented by a volume slider. Mono controlsalways have a single slider while stereo controls can have either oneor two sliders, depending on your settings. There is also a panningslider at the bottom of the window. If your system has more than onesound card, a list will be displayed at the top of the window.
The Kmix window can have up to three different sections, Output,Input, and Switches. Each section will contain volume sliders,switches for enabling/disabling record or playback functions, andmultiple choice selectors.
Output: This tab holds the controls that are most likely related toplayback, like the Master volume control.
Input: This tab holds the controls that are most likely record related,like Capture.
Switches: These controls allow you to switch certain functions Onand Off, like External Amplifier.
Kmix also features LEDs. The general coloring rule is as follows:
Green: An LED dealing with playbackRed: An LED dealing with recordingYellow: An LED dealing with special sound card capabilities
A lit LED means On, a non-lit LED means OFF.
In most situations the volume can be adjusted by clicking on theVolume Control applet on the Panel and raising or lowering the slideraccordingly.
PLAYING AUDIO CDS

You can play an audio CD by placing the CD into the CD-ROM drive.The CD player application (KsCD) will be run automatically to play theCD. Ensure that your speakers are turned on so that you can hear theCD! You can also manually start the CD Player application from theMain Menu:
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Main Menu -> Multimedia -> Sound -> KsCD

Fig. CD Player
You can control the CD Player just like a normal CD player with thebuttons shown on the CD Player screen. These include volumecontrol, track forward/backward, play/pause, stop, eject as well asjumping to any track on the CD directly.
PLAYING DIGITAL AUDIO FILES

PCLinuxOS gives us Amarok which is arguably the most completemusic manager available today. Amarok serves many functions ratherthan just playing music files. For example, Amarok can be used toorganize a library of music into folders according to genre, artist, andalbum, can edit tags attached to most music formats, associatealbum art, attach lyrics, and automatically "score" music as you play it.

Fig. Amarok
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Amarok plays media files in various formats including but not limitedto (depending on the setup), Flac, Ogg, Mp3, AAC, WAV, WMV, andMusepack.
Note: Amarok will not play digital music files protected by DRM, suchas those purchased from the Itunes Music Store.
It also can Sync, retrieve, play, and upload music to digital musicplayers, such as Ipods or Creative Zens.
Note: To work with Creative Zens or other MTP devices, libmtp0 willneed to be installed from the repositories.
One last notable feature is Last.fm support, including submittingplayed tracks (including those played on some digital music players)to Last.fm, retrieving similar artists, and playing Last.fm streams.
You can find Amarok by going to:
Main Menu -> Multimedia -> Sound -> Amarok
Another excellent player that is in the repositories and can be easilyinstalled is XMMS. The XMMS (X Multimedia System) application canbe utilized to play a wide variety of digital audio file formats. Theseinclude the popular MP3 as well as the open Ogg Vorbis formats. Tolaunch XMMS, (after it is installed) select:
Main Menu -> Multimedia -> Sound -> XMMS

Fig. XMMS Player
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Note: XMMS may need additional plug-ins to be able to play some ofthe audio file formats. If these are not already installed on yoursystem they can be installed from the repositories using Synaptic.
You can control the XMMS player using the graphical knobs andbuttons displayed. In addition, you can select the source of the audiofiles to play. To do this, right-click on the XMMS player and from thepop-up menu select "Play File" to select the audio file to play. If youwant to be able to play an audio file from the Internet select "PlayLocation" and enter the Internet location of the file.
PLAYING VCD AND DVD

There are several excellent applications readily available for you touse to play VCD and DVD media. Here we shall look at two of them:Kaffeine and Mplayer. These can also play CD and digital audiomusic files.
KAFFEINE

The Kaffeine application may be used to play VCD and DVD. You canstart Kaffeine from the Main Menu:
Main Menu --> Multimedia --> Video -> Kaffeine
The Kaffeine user interface is highly intuitive as it resembles a normalVCD/DVD player with all the basic control knobs and buttons.

Fig. Kaffeine Control Panel
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To play a VCD, place the VCD into the CD-ROM drive and click on thePlay VCD button on the Kaffeine control panel.
To play a DVD, place the DVD into the DVD drive and your movieshould start playing. If it does not then right click on the DVD icon onyour desktop and choose "Play DVD with Kaffeine."
The volume control can be adjusted by clicking on the volume controlbutton.
Kaffeine is a very powerful multimedia application with manyfeatures. It can also play audio CDs as well as digital audio files.Note: to be able to play encrypted DVDs you will need to installlibdvdcss and win32codecs from the repositories using Synaptic. Youwill need to check to see if the use of these libraries is legal as it isconsidered illegal to use this in certain parts of the world.
MPLAYER

Mplayer is a popular movie player for Linux. In addition to being ableto play VCD and DVD it is also able to handle a wide variety of audioand video files and streaming data formats. Hence it is useful to useMplayer as the universal multimedia player. The Mplayer GUI can bestarted from the Main Menu,
Main Menu -> Multimedia -> Video ->MPlayer
On start up, the main Mplayer control screen and the Mplayer videooutput screens are displayed.

Fig. Mplayer Control Screen
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Fig. Mplayer Video Screen
The control screen enables you to control the operations of Mplayerwhile the video screen displays any video that is being played. Inaddition, right-clicking with the mouse when it is inside either thecontrol or video screens will also bring up a menu for controlling theuse of Mplayer.
The Mplayer control screen enables you to perform the following:

• start, stop and pause play• go to the next and previous stream• jump to the first and last tracks• adjust the sound balance• adjust the volume and mute• select files to play• set up a playlist• set the video and audio equalizer• configure preferences
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• exit the Mplayer application
All of the functions are represented by intuitive knob, dial, andbutton icons on the control screen making it very easy to use Mplayer.
To play a VCD, place the VCD in the CD-ROM drive, move the mouseover the control screen or video screen and right-click it. Select,VCD -> Open disk
To play a DVD, perform the above for VCD but instead select,DVD -> Open disk
The size of the video screen can be controlled by right-clicking onthe mouse and selecting normal size, double size or full screen.When you are in the full screen mode, to return to normal size, right-click on the mouse and select normal size.
EXERCISES

1.Play an audio CD using the KsCD Player2.Play an audio digital music track using Amarok3.Play a VCD or DVD using Kaffeine and MPlayer

GRAPHIC IMAGES ACCESS

Very often it is useful if we are able to view graphic image files ontheir own, or in thumbnail fashion if there are many of them. It isalso useful if there are simple tools available which will enable us tomanage these image files, e.g. catalog and classify them and recallthem for viewing. In this section, we shall look at several toolsavailable on your system which provide some of these functionalities.
FILE MANAGER

The File Manager itself provides a simple and convenient means toaccess and view image files. To view an image file from the FileManager, move your mouse pointer over the file and a largerthumbnail picture will appear. To view the file full size double clickon it. Another convenient way of viewing when you have a lot of filesin a folder is to select the "View Mode > Photobook" option from theView menu selection.
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Fig. Photobook View in File Manager
This will result in only the image files present in the folder beingdisplayed. You can then select an individual image to view and alsoperform zoom in or zoom out views.
DIGIKAM CAMERA ACCESS

Digikam is a simple digital photo management application, whichmakes importing and organizing digital photos a "snap". The photoscan be organized in "albums" which are automatically sortedchronologically. An easy to use interface is provided to connect toyour camera and preview images and download and/or delete them.
Digikam uses a folder on your file system as an album library,meaning that every sub folder of this folder will be considered as aphoto album and displayed in the album list on the left side of themain window.
Clicking on an album will start showing the thumbnails for theimages in the album. You can change the icon size to small, medium,



large or huge from the magnify buttons in the toolbar. Right Clickingon an item will give you a pop-up menu, using which you can view,rename, delete, see the edit information, and add/edit comments ofthe images. Double clicking on an item will open it up in the imageviewer.
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Fig. DigiKam Photo Manager
To be able to use your digital camera with Digikam, connect thecamera to your computer, switch the camera to the image displaymode and turn it on. If your camera is detected as a mass storagedevice (ex. sda1) a "New Medium Found" window will be displayed onyour desktop along with an icon. If this does not happen when youplug your camera in and turn it on then you will need to setup thecamera model and port using the setup interface. Try and see ifDigikam can auto-detect the camera; if not, you can set the cameramodel and port manually.
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Fig. Camera Configuration
Once you have the camera setup, go to the "Cameras" menu in themain interface and you will see the camera listed in the menu (Note:You can choose any title you like for the camera in the setup and thistitle will be used in the "Cameras" menu). If you have more than onecamera, you can add them throughout the setup interface.
Clicking on the camera item in the menu will pop up a new CameraInterface and this will connect to the camera, and thumbnails (ifsupported by the camera) will be downloaded and displayed. You canthen select the images and download or delete them from thecamera. Downloading can be done by using the menu/toolbarbuttons or by dragging and dropping them onto an album folder orany other folder that you choose.
Digital cameras nowadays store images on either a CompactFlashcard, SD card, or SmartMedia card. The camera internally makes subfolders in these storage media which it uses to save the images.Digikam displays these internal folder trees and also provides aglobal virtual folder which shows all the images available in thecamera.



When you open the camera interface for the first time the folders arehidden and the contents of the global virtual folder are shown (i.e. allthe pictures in the camera). You can choose to see the actual folderson the camera by unselecting "Hide Folders" in the "View" menu. Thiswill show the folders on the camera, the topmost folder being theglobal virtual folder. Clicking on a folder will show the contents ofthe folder in the thumbnail view.
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Fig. DigiKam Camera Client
SHOWFOTO IMAGE VIEWER

The showFoto image viewer is a powerful tool for viewing, andorganizing graphic image files. To start this application perform:
Main Menu -> Multimedia -> Graphics ->showFoto



Fig. showFoto Image Viewer
VIEW

The simplest way to view an image is to double-click on the name ofthe image and it will be displayed in full. You can also navigate to thenext/previous image as well as go to full-screen viewing. The Zoomfunction can be used to zoom in or out of the image currently beingdisplayed. Click on the Folders button at the top of the screen to goback to the thumbnail view. A preview of the image will be displayedin the preview area if you just select the thumbnail.
One useful feature of showFoto is the slide show. After a folder hasbeen opened (File > Open folder), selecting View > Slide Show willstart a full screen slide show of the images in that folder.
IMAGE MANIPULATION

You can also manipulate the images under showFoto. Somesupported functions include rotation, flipping, resizing, and Blowup.To access these functions select "Transform" from the menu bar atthe top. Additional tools for working on your graphics files can befound under the Fix menu.
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CONVERT FORMAT

The Save As function of showFoto allows you to convert your imagefiles from one format to another. Some of the 14 supported formatsare:
Portable Network Graphics (PNG)Joint Photographic Experts Group (JPEG, JPG)Tag Image File Format (TIFF)TARGA format (TGA)
To use the Convert function, select an image first and then from thetop menu bar, select,
File -> Save As
and choose whichever format you would like to save to from the dropdown list.
HELP

showFoto has many other useful features. The online help guideshould be consulted for more details on how to use showFoto.
showFoto Handbook
EXERCISES

Use showFoto for the following:1. View the images in the following folder:usr/share/backgrounds/images2. View a slide show of the images in the folder above.3. Copy one of the images from the above folder into your homedirectory and scale it down to 25% of its original size and save it.

http://docs.kde.org/development/en/extragear-graphics/showfoto/index.html


MS Vista/Linux Dual Boot Tutorial

by Gimlet
Many people and I have discovered that the new MS OS Vista has anew boot loader. Creating a dual boot system can no longer beaccomplished with the usual methods. Here is a solution that I havefound to be quick and simple.
If you are starting with Vista installed, do a volume defragmentationusing the Windows defragmentation tools. When the defragmentationhas finished, go to Start/Control Panel/Administrative Tools. SelectComputer Management, then Disk Management.

Fig. Disk Management window
Select your Windows hard drive with a right click and select "ShrinkVolume" from the sub menu. Shrink your partition to allow for yourLinux install. 2 gig swap, 10 gig /, and whatever you want for /home.Close down all open windows.
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Fig. Shrink Volume
Download and install EasyBCD. It can be found at the link below:
http://neosmart.net/dl.php?id=1
Take your Linux Distro of choice (mine is PCLinuxOS) and do aninstall. Follow the instructions. When you reach the point where thedistro asks you where you want to install Grub/Lilo, make sure youtell it to install to /root. That means the partition you installed Linuxto. Make sure it is not installed to the MBR. When you are finishedyour install, reboot.
Ok don’t be surprised when all you see is Windows rebooting. This iswhere EasyBCD comes into play. Start EasyBCD. It should look likethis:

http://neosmart.net/dl.php?id=1
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Fig. EasyBCD
Select Add/Remove Entries
Then select the Linux/BSD tab on the bottom right. Now click on theType drop down menu and select the type of boot loader youinstalled (Grub/Lilo). Next, give it a name in the name box.(PCLinuxOS)
Now here comes the only part that confused me but, that happens alot. Look to the bottom left again. You will see two entries, HardDrive and Partition. In my case I have only one hard drive so the harddrive is "0" and the / partition is "3." Here is why. Windows is on thefirst partition, swap is the second partition, and root (/) was on thethird partition. So if you had two hard drives and Linux was on thesecond hard drive and you setup the drive with swap first, then root,then home, you would select hard drive "1" and partition "2." Click"add entry" and you are done.
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Fig. Add/ Remove Window
Reboot Windows and you should be greeted with a black screen withwhite text listing the two operating systems. Select the Linux entryand you should see the Grub/Lilo boot loader. Select your OS andaway you go.
If for any reason you want to remove Linux and get your Vista bootloader back, just fire up EasyBCD and select Manage Bootloader, setyour options, and click write MBR
I hope this is helpful. I am sure there are other ways to do this but Ihave found this simple and quick. I have been using it for severalmonths with no problems.



A Simple Backup Method Using Grsync

by Iain Jackson (iainrj on PCLOS and MYPCLOS forums)
This article is a simple tutorial on using Grsync as a backup utility,There have been a lot of threads on the main forum from usersasking for advice on backup and I have found Grsync to be thesimplest and quickest method around.
Grysnc is a GUI-front-end for the command line application rsync.Rsync has many powerful applications, not least for synchronisingdata to web servers. In fact rsync scripts are used by Texstar forsynchronising the repositories as new applications are added.
This short tutorial will show you how you can use Grsync to back upyour /home directory to either another hard drive, partition orremovable drive.
Your /home directory is where all your e-mails and bookmarks arestored in hidden folders. To view them open home in Konqueror andclick on View|Show hidden files. Depending upon which applicationsyou are using you might see a .mozilla folder containing your Firefoxbookmarks and extensions; a .thunderbird containing your e-mailsand a .kde folder containing your desktop settings and settings fromKDE applications such as kmail.
1. INSTALL GRYSNC FROM SYNAPTIC.Once installed, you will see the application under KMenu-->Internet-->File Transfer. It might be a good idea to create a desktop icon foreasy access. To do so, right-click the icon in the k-menu and thenchoose Add Item to Desktop:
2. a) If you want to backup to a removable medium such as a USBflash drive or external USB drive, insert it now. When PCLOS detectsthe drive, click on Open in New Window to mount the drive:

b) It is a good idea to create a new directory on your removabledisk to store the backup files. In your new window create a newfolder. As an example, home.backup is the directory name I use. Tocreate a folder, click on Edit|Create New|Folder.
Use the panel icon to go back to Grsync once your media is mounted.
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3. CREATE A BACKUP SESSION.a) When you launch Grsync you will see this screen:b) Click on Add in the Sessions section and enter a session name.This is just so that once configured, you can quickly run the samebackup routine by choosing the session. Type something like “HomeBackup” and then click OK:
c) You now need to add your source and destination directories.There are 2 blank boxes in the middle of the Grsync window. The topbox is the source - this is where your files currently are. The bottombox is the destination - where you want your files backed up to.
d) Click on Browse next to the source box. This should take youstraight to your home directory. Just click on Open to select it:
e) Click on Browse next to the destination box. Your removabledrive should have appeared as a link on the left hand side of the filedialog for easy access. Double-click it, then double-click on yourbackup folder before choosing Open:

4. CHANGE THE BASIC OPTIONS.a) It's probably a good idea to select Preserve Owner, Groups andPermissions so that if you need to reinstate from the backup, youwon't get into any ownership problems.
b) Select Delete on Destination to ensure that you don't end upwith any old files in your backup that don't exist in your homedirectory.

5. ADVANCED OPTIONS.a) Check the Copy symlinks as symlinks box. This means that ifthere are any links to files, only the link, rather than the file itself iscopied over.
b) Additional options are useful if you want to add other rsync orconsole commands. The one I use is the exclude command. Theexample below excludes the .thumbnails directory from the backup:
c) To find out all available rsync commands type man rsync into aterminal.
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6. Do a “dry run”. Click on Simulation and you’ll get a quick runthrough of what is going to be copied over.
7. When you are satisfied all the correct files are being either deletedor copied, click on Execute. The first time you run the sync it maytake a while as it has to transfer all your data. The exact time willdepend upon the amount of data you are copying and the speed ofyour computer. It might take 5-10 minutes to transfer your /homethe first time out, longer if you have a lot of large files such as audioor movie files.
Subsequent syncs will be much quicker, perhaps 30 seconds, as itonly sends new or updated files for backup:
Grsync makes using rsync easy but doesn’t give you the fullfunctionality. If you want to have a go at creating scheduled backups,you can write rsync scripts and use cron or Kcron to schedule thetasks. Here’s a good website that takes you through that process:http://www.mikerubel.org/computers/rsync_snapshots/#Rsync
For me, Grsync works a treat. About once a week, I switch on myexternal hard drive, and run my 2 Grsync sessions - one for /homeand one for my data partition. The whole process takes about 5minutes and I am safe in the knowledge if I need a clean reinstall ofPCLOS I have all my application settings, e-mails, bookmarks andmore importantly my music and photos backed up.

http://www.lortal.org
http://www.mikerubel.org/computers/rsync_snapshots/#Rsync


Not Everyone's Body is Unimpaired

by Heather
Summer arrived with a flourish here in my corner of the world. Its been ahot summer so far, one I must admit I am enjoying very much, probablybecause the other 11 months are full of snow. However, though my localPride Parade (a parade put on by our local gay community) got rained onrather nastily, it didn't douse the spirits of the people present andespecially not the spirits of Steve, a friend of mine.
I don't see Steve often anymore since I don't go to the bar much now,but when I did I often talked to him and danced with him whenpossible. My girlfriend introduced us and she said she knew right offI'd have no prejudices against dancing with someone with CP(Cerebral Palsy) even if they were in a wheelchair or needed helpseeing their way to the floor. She was right, as she usually is, andseeing Steve since then has been a joy because he is always smiling.Seeing him this year reminded me that I have been meaning to writesomething for this column that serves what I feel is an under-servedsection of the community: those with various disabilities or needingaid to use their computers in any way.
Certain people like Steve have less of an issue with their laptops anddesktops if they are reasonably able to use a pointing device, butwhat of others? What about people who are deaf or hard of hearing(HoH)? Having worked with deaf/HoH people for a year, I becameacutely aware of their issues many years ago. It seems their needsare being met more and more but I have to wonder if this is true inthe FOSS community or just the commercial realm.
Then there are those who are legally or totally blind. Where do they fitinto all of this? How do they access what is, for all intents andpurposes, a very visual medium? GUI or command line, it will makelittle difference to them which they use if they can't see what it is theyare trying to access. I've seen a couple of specialist distros thataddress this (Oralux is the one I tried on my own desktop and I willaddress it in another column if possible). I have become aware of toolson the major DE's that can also help people who face these challenges.However, I also admit my knowledge in this area is woefully inadequate.Do such tools exist outside of the KDE/Gnome desktops?
Then we arrive at the people whose disabilities are more pronouncedthan Steve's. People who, for whatever reason, are incapable of using



a standard mouse or trackpad or trackball. There are those who can moveonly their eyes or need to use a mouthstick. Where do they go and whatsupport can be offered to them? Is there specialized hardware availablefor these people and if so where would one go to access such things?Dare I even hope that the drivers used to tell these devices how to behaveon a standard Linux installation work on Linux at all? Where are thedevelopers doing the nitty-gritty work on these kinds of coding problems?
I'm sure I've missed some form of disability or some such thing inthere. This is why I am calling upon you, my loyal readers, to help me.If it's possible for you to help me with this small series of articles, I'dlike your input on these issues! Write in, give me ideas on where tolook for information or name a distro you have tried that uses specialhardware or software to help those with disabilities of any kind. If youcannot try a distro but want me (or someone I know) to try it out andgive a short synopsis of how useful it might be, write in! I'm lookingfor readers to point out, as well, where things can be improved when itcomes to helping you use the technology we have available to us today.Which companies are doing the R & D to solve these issues? Whichbusinesses have a decent headset for someone with very limitedmobility so she can use a head pointer to move a cursor around on thescreen? Is it expensive? Does it require special setup or knowledge toset it up on the system? In other words, is it plug and play?
I know that the Debian distro has had, for some time now, Emac-Speak built-in and Braille drivers that allow the blind to use theirbraille hardware with a regular computer using linux. Do you know ofany other distros out there that work extra hard to help all usersaccess their computer? Write in and tell us what you think of thatdistro or ask us to review it if you like. Heck, review it yourself andwrite us anyway! Most importantly I want my readers to write in andtell me what they want me to address in the next few columns on thesubject of disability and Linux. I want to hear what you have to sayand I want to know what aspects of Linux you want me to cover so wecan, perhaps, help you to enjoy using your computer instead ofhaving to fight with it to get your tasks done.
Lastly if any of your friends or family wish to write in to point outthings we might look at addressing, please tell them to do so. Weare happy to receive such emails and I hope we can get to them.With luck we will manage to address the issues they might bring uptoo.
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LinuxTracker, Torrent Seeding and Your Client

by John Coombe
BitTorrent files, colloquially torrents, are the most popular method ofsharing files among people all over the Internet now because it istrue peer to peer sharing. The servers do not host any files, only theidentifying files called tracking files. These are used to enable theservers to keep track of who has what part of which file and toallocate priorities to the packets being sent.
The LinuxTracker site serves huge numbers of distros' torrents and isnot exclusively for the use of PCLinuxOS. Because of the largenumbers of torrents that are active at any given time, it is notuncommon for individual BT clients to not be able to connect to thetracker sometimes due to the amount of traffic that the siteencounters 24/7 x 52 weeks/year.
Usually, if you go back and look at your BT client an hour or twolater, it will likely show something different.
An example of what is happening at the LinuxTracker (from bottomof main page) - this changes all the timeTracking 2,673 Torrents with 237,110 Peers (84,505 Seeders and152,605 Leechers)Current Seeder/Leecher Ratio (%) = 55%Total Registered Users 25,080Members Online (Now): 13 MembersMembers Online (In last 24 Hours): 312 MembersMost Users Online: 594 Members on: 2007-04-20 08:15:41
So you can see it is not uncommon for several thousand torrents tobe active at any given time and just look at the numbers ofseeds/leeches. All of them have to communicate with LinuxTracker.Due to this fact, it is normal that the SiteAdmin of this tracker (andothers) sets the time that the tracker sends out an update request toeach peer to around an hour. If the update request was made morefrequent than once an hour, the amount of network bandwidth wouldbe humongous, and he would have to pay for that. Also, if it wasmade more frequent, it could act like a DOS (denial of service) for thesite. This aspect of busy sites is well known. There are some siteswhere the update request has been set at 2 hours to reduce traffic.
If, due to the amount of traffic collisions, an individual BT client
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misses getting the update request, then you may have to wait foranother hour for it to happen again. It does not mean all theseeds/leeches have vanished, it just means your BT client missed thelast update request.
Of course, this is for a torrent that is still active and has a lot of peersusing it and so lots of traffic. Eventually everyone downloads thefile(s) and has finished leeching. So all the seeds stop bothering tocontinue to seed. Sometimes a torrent becomes what is called a deadtorrent, and if you try to download (leech), you fail unless a seed iskind enough to restart for you! When a seed is 'dead' no matter howlong you wait, it will stay dead. Even if you get an update requestfrom the tracker you will never be able to connect to another peerbecause there are not any left. When a torrent is dead, it is dead. :-(
A snapshot look at the torrent statistics at the LinuxTracker siteshows: 4712 completed 368 seeds 132 leeches. Another snapshotlook in 5, 15, or 30 minutes would show the number ofseeds/leeches higher or lower, depending on the traffic during thattime.
I hope that gives some sort of concept as to what is happening.

Our grateful appreciation to MyPCLinuxOS.com
and Devnet for making this project possible.

The PCLinuxOS
Hardware Database

http://www.mypclinuxos.com
http://www.pclinuxoshwdb.com/


A User's Story

On 6/10/07, s0l1dsnak3123 <s0l1dsnak3123@googlemail.com>wrote:
First of all, I'd love to congratulate Texstar and his gang on theiramazing distro. It beats most commercial distros by quite a largedistance. I have tried many distros, including SimplyMEPIS, openSUSE,Ubuntu, Kubuntu, and BackTrack, and I can easily say that this one isthe best.
Second, I'd like to thank you for this magazine, as it has helped meunderstand many things about Linux. Linux is a complicated beast,and I am proud to say that this magazine has helped me straightenthings out.
I am a 3rd year student at my high school, and I recently had a solo-talk (basically a presentation) on Linux in front of the class. Manypeople came up with different things, ranging from Elvis Presley toTom Crean. I chose Linus Torvalds (in part an excuse to advertisePCLOS and Linux in general to my class). I used a Power Pointpresentation with built-in videos of various functions and (of course)the fanciest bells and whistles that Linux currently enjoys (Beryl, forexample). After I showed all of these videos, I showed a diagram Ihad made of all the different parts of the desktop, noting thetransparency and handy features that other, more popular operatingsystems lack. I showed how easy it was to change window managersand presented some facts and figures on Linux's reliability, and'customizability'.
My fellow pupils watched in awe at Beryl's beautiful effects. Theystared on at the customizations. However, I held one main factor tothe end. In fact, a pupil asked me before I got to say it... the price.When I told them it was free, they didn't believe me. When my Englishteacher asked what was the catch, and I said simply that there wasn'tone, nobody believed me still. When I told them about the GPL, theydidn't understand what was in it for the programmers, GFX designers,etc. I told them that the main reason is because they want people touse it, modify it, pass it on, freely, without any restrictionswhatsoever, and the only way for that to happen would be for it to befree. By this time people wanted to know where to get "it", so I toldeverybody the addresses for Distrowatch and PCLOS.
People now wanted to know how to burn the disk, but I had prepared
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for this question. I gave out copies of PCLOS TR3 which everyone inmy class took home with glee. I also gave them instructions on howto start up the disk and install. My class has 20 pupils, 19 of whichown a computer. A couple of weeks ago, I asked how many peoplehad tried out PCLOS and 18 out of the 19 raised their hand. I askedhow many people used it weekly and I am proud to say that only 1person put his hand down. That means out of 19 people who havecomputers in my class, 17 use PCLOS weekly. Is that success or what?I was thrilled to see my English teacher ask how to install PCLOS overhis Windows XP install. I think Linux will be a big hit in years to come.
A lot of my friends hated Windows Vista so much they reverted backto XP. Remember, they aren't 'technical' per se, so they didn't knowabout the performance problems, security problems, etc. While thereis a want for an alternative, the Linux community has a chance to gomainstream. First things first though: we need to get rid of the jargonand make Linux more friendly. When I say friendly, I do not mean sothat the average newbie will understand. We must remember that thenewbie knew how to search Google. He/she also knew how to poston a forum. Many people I know don't even know what a forum is. Ialso know many people who just use their OS for Runescape.
Linux must stay powerful, but become a more beginner-friendly OS.Take the command line, for example. It is necessary in Linux, butwhen was the last time the average user used the command line?Probably never. Programs have the GUI built in. Compilers? I doubtthe average user knows how to compile a program. Some barelymanage installing a program in Windows with the installers such asmsi and NSIS. If the Linux community went through something asdrastic as this, it would mean a hell of a lot of work... but I believe itwould be worth it in the long run.
Just my £0.02,
John AKA s0l1dsnak3123
regards,John



Installing and Using Peerguardian on PCLinuxOS

INSTALLATION AND FIRST USE

Privacy is a big issue in the online world. Big money is made sellingour personal information. For those who frequently download usingPeer-to-Peer programs, Peerguardian might be a good addition totheir system.
Peerguardian runs in the background of your system and is silentlyblocking a large range of IPs that have been known to do evil things,for instance, IPs from government organisations trying to monitordownloading behaviour, spyware trackers, etc. Whenever yourcomputer tries to make any connection to one of these blacklistedIP's, Peerguardian will prevent it and protect your computer. Iconsider it a must-have for every computer using P2P applications.
Peerguardian is not (yet) available through the 2007 repositories, sowe'll have to download the source code from the main website.http://prdownloads.sourceforge.net/peerguardian/pglinux-1.5beta.tar.gz. Save this somewhere on your harddrive and unpackthe source where you want to compile it (e.g.: ~/src/pglinux).
I know a lot of you will probably say something like, “Source code??I've never done that! HELP!!” Trust me, it's not that difficult and I willguide you through the process.
First start Synaptic, locate the 'iptables', the 'iptables-devel',the 'ipset' and the 'gcc-c++' packages and install them. You'll needthem to compile Peerguardian.
Now go back to your source directory and open a terminal window.Type './configure' and type the enter key. You'll see a long listbeing made of things getting checked. This process will check to seethat everything is ok and will create the configuration files needed forthe compile.
Finally the list will stop running, stating “It's ok to start your makenow”, do so by entering the 'make' command. Again there will be alot of gibberish in the terminal window, but if it completes you'll havea freshly built peerguardnf-binary at the ready. As root, copy thisbinairy to /usr/bin using the command 'cp -a ./peerguardnf
/usr/bin'. (Some people may say that 'make install' is a better

http://prdownloads.sourceforge.net/peerguardian/pglinux-1.5beta.tar.gz
http://prdownloads.sourceforge.net/peerguardian/pglinux-1.5beta.tar.gz
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solution for installing the binary. That is absolutely correct, but forsome reason, it doesn't work. And the package is no longer beingmaintained, so we'll stick to copying it instead.)
STARTING PEERGUARDIAN

There are two ways of starting Peerguardian, either automatically bya script which will do all the work for you, or by doing things byhand, leaving more room for configuration.
If you want to do it automatically with a script, you're lucky becauseI've provided one for you. It updates the lists of blocked IP's frombluetack.co.uk (level 1&2 blocklists) and tells you when Peerguardianhas loaded successfully (or not). You can download this script athttp://www.xs4all.nl/~dutourge/start_peerguardian. In order for thescript to work, you have to make it executable. Do so by typing thecommand 'chmod a+x ./start_peerguardian' in the directorythat contains the script. Now you can just start Peerguardian bydouble-clicking the script. If you wish to check whether all is goingwell, you might want to take a look inside the logfile. It'll be locatedunder ~/.pglinux/pglog.txt.
If you want to start Peerguadian manually, here's how.
Pick up some blocklists from http://www.bluetack.co.uk. In the topright corner there is a link 'blocklists' which will lead you to thedownload page. As you can see, the IPs have been split up underseveral categories, e.g.: Spyware, Level1, Addons, etc... The Level1blocklist is the most important one, it contains the largest list withbad IP's everyone ought to have blocked. The others are optional.
You can download one by clicking on it and agreeing to the license.Save the *.zip file to a location of your choice. Unzip it, and you'llfind a regular textfile inside. This is useful, because if you downloadmultiple blocklists, you can just paste one underneath. Rememberthe location of the textfile, since you need it to start Peerguardian.
Now it's time to start Peerguadian itself...
First load the ip_queue module by typing 'modprobe ip_queue', it'sneeded to run Peerguardian

http://www.xs4all.nl/~dutourge/start_peerguardian
http://www.bluetack.co.uk
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As an example I'll take my regular command to start Peerguardian(note: peerguardnf must be run as root. If you type 'peerguardnf --help' you'll get a full list of options. I'll use just a few of them in thistutorial. ):
$ peerguardnf -d -l /home/rick/.pglinux/pglog
/home/rick/.pglinux/level1.txt

• '-d' will start the program in daemon mode, it will run as abackground application allowing you to close the terminal windows
• '-l /home/user/pglinux/pglog' will write all ouput/errorsto a logfile for later analysis
• '/home/user/pglinux/level1.txt' is the path to theblocklist peerguardian will read 'bad IPs' from

If the loading was successful, the log will read something like this:
Reading blocklist
detected ASCII blocklist
Entering daemon mode
Blocking 140336 ranges (735355236 IP addresses)

Congratulations, you've just started Peerguardian for the first time! Ifyou want to stop it again, open Ksysguard and kill peerguardnf.

http://www.distrowatch.com/
http://www.tuxmachines.org/


Use Amarok To Transfer Music Files To Your Zen

by Papawoob
Just a short How-To that took me considerable time to figure out.Hope this saves someone from the trials and tribulations of having tofigure this out for themselves. This will only work on a 2007 install.On .93, either Amarok, or libmtp0 was not quite there yet. You cantransfer files but, the names will all appear in Chinese characterswhich, if you can read Chinese would be great I suppose but, I am notable to read Chinese. In 2007 it works like a charm!
Open Synaptic and install "libmtp0" then close Synaptic.
Open Amarok -> Main menu ->Multimedia -> Sound -> Amarok
If this is your first time opening Amarok it will ask you someconfiguration questions like where do you store your music so that itcan import it and organize it. Unless you prefer some other musicmanager I would go ahead and let your music be imported.
Go to Settings -> Configure Amarok -> Media Devices ->Add Device

Fig. Add Device
You will see a window with 3 boxes like the one above. Click thearrow to the right of the first box and choose "MTP Media Device." Inthe second box enter a name for your device like "My Zen." Leave thethird box alone and then click "OK."
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Fig. Configure Amarok
You should now see it listed at the top of the Configure Amarokwindow. Click "Apply" and then "OK."
You will now be back at the main window. In the bottom left corneryou should see a tab that shows the first few characters of the nameyou gave your Zen (in wy case, “Devi...”). Click this and at the topyou should see a "Connect", a "Disconnect", and a "Transfer" button.
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Fig. Amarok main window
At this point you can now plug your Zen into your USB port. Next,click "Connect" and you should see your Zen connect. If you have anymusic files on your Zen they will appear in the left hand window.
Browse to the folder where you store your music and open it. Movethe two windows around so that you can see the left half of theAmarok window and as many of your music files as possible.
Drag and drop all of the files you want to transfer to the left half ofthe Amarok window. (NOTE: when you drop the first file the windowwill split in half and you will see the file you dropped in the bottomwindow. Continue to drop files in the bottom window until you haveeverything you want to transfer.)
Next, click the "Transfer" button and you should see the files beingtransferred to your Zen.
When the transfer is complete, click the "Disconnect" button and itwill now be safe to remove your Zen from the USB port.
Happy Zenning!



Installing PCLinuxOS on a Windows XP HD

by youcantoo@findmoore.net
INSTALLING PCLINUXOS ON A HARD DRIVE WITH WINDOWS
XP ALREADY INSTALLED.

Start by booting your system with the PCLinuxOS Live CD. When youget to the log in screen, select the user name “root” with thepassword also as root. Once the desk top loads, double click on thepackage management (Synaptic) icon. It's the one with the red andblack circular icon at the bottom of the screen.

Once it loads, you should now see something similar to the pictureson the next page.
Now, you want to search for and load some software that will allowLinux to read and write to the Windows NTFS file system. At the topof the Synaptic screen, click on the search icon. This will open thesearch dialog box. In the dialog box, type in “NTFS”, and oncecompleted, click on the “search” button.
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Now, Synaptic will search for all the programs containing yourselected search term “NTFS”. You should see something similar to thewindow below.
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Now click on the little box next to the “ntfs-3g”. This will open adialog box as in the following picture.
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Click on the “Mark for Installation” line. This will select the “ntfs-3g”file for installation. It now will tell us that we need to mark additionalchanges. Click on the “Mark” button in the dialog box.

Now you want to apply and install the “ntfs” programs. Click on the“apply” button at the top of the window.
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Click on the “Apply” button in the lower right corner of the dialogbox. Synaptic will now go about installing the requested software.Once Synaptic has downloaded the software requested, it will installthe software and update PCLinuxOS. You will see a screen similar tothe following.
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Once Synaptic has finished loading your requested software, youshould see a window similar to the one which you started.

Note that the file “ntfs-3g” now has a green box proceeding it, tellingyou that this software has been installed on your system. At thispoint, close Synaptic, by clicking on the “X” in the little red box at thetop right hand corner of the Synaptic window. You are now back atthe desktop. Now you are going to prepare to resize your hard drivefor the Linux installation. Click on the “Konsole” icon.

Advertisement

http://www.pclinuxos.com/
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You should now see a “Konsole” window link as in the followingpicture. In the Konsole window, type “draklive-install”, and thenpress the enter/return key.
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This will start the partition/install program.

Click on the “Next button in the dialog box.
In the following window, you are going to select the hard drive onwhich you want to install Linux.
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Use the default hard drive, and click the “Next” button. Make sure toselect “Use the free space on the Windows partition”. Then click onthe “Next” button.

A friendly reminder. You are about to resize your Windows partition.You did defrag your windows drive before starting this, didn't you??If not, you could lose all your windows setup. If you DID NOT firstdefragment your Windows Drive, CANCEL now and defrag yourWindows system! Did you also backup your important files? Whenyou are ready, press the “Next” button in the dialog box to continue.
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Pick the partition that you want to resize. Note it is normally labeled“hda1” and is usually the default partition. Click the “Next” button inthe dialog box.

You are now ready to do the actual resizing of the Windows partition.Using the slider bar, select the size that you want the new windowspartition to become. To make a 20 gig Windows partition, choose20480.
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For the following size Windows partition, use the following numbers:
10 gigabyte hard drive use 1024015 gigabyte hard drive use 1536020 gigabyte hard drive use 2048025 gigabyte hard drive use 2560030 gigabyte hard drive use 3072035 gigabyte hard drive use 3584040 gigabyte hard drive use 4096045 gigabyte hard drive use 4608050 gigabyte hard drive use 51200

Use the slider bar to get close to the number you want, then use the“left” or “right” arrow keys for finer control.

The screen shows a final warning before the resizing and formattingtakes place. Click the “Next” button in the dialog box.
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After resizing the Windows partition, Linux will then setup, format itits own partition to use.

After formatting is completed. you will be notified that the next timeWindows is started, it will do a data integrity check first.
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Click the “OK” button in the dialog box.
Now Linux is going to install itself on your newly partitioned harddrive.

The Linux software installation will take a few minutes depending onthe speed of your computer.
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Once Linux has installed itself on your hard drive, it will ask aboutthe booting options. At this point use the DEFAULT settings. Clickthe “Next” button to continue.

Again, use the DEFAULT settings. Click the “Finish” button in thedialog box.
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Now it is time to set the “ROOT” user password. Select a passwordthat is difficult enough that it will not be guessed, but also one thatis easily remembered by you. Remember that the root password ispart of what makes your new Linux system secure. Choose it wisely!After entering your “root” password, click the “Next” button in thedialog box.
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Now, it's time to add the user's names and passwords.

To change the icon, click on the icon picture. When you are finished,click the “Accept user” button. When finished, click the “Done” button.

Congratulations, you have managed to resize your Windows harddrive and install PCLinuxOS in a dual-boot configuration. To finish,click on the “Finished” button in the dialog box.
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At this point, you should be back to the Live CD desktop with the“Konsole” window open. Close the “Konsole” window by clicking the“X” at the top right of the “Konsole” window. Now it is time toshutdown and reboot your system. At the bottom left corner of thedesktop, click on the Linux “PC” logo. From the menu, choose“logout” in the dialog box. Click on the “Restart Computer” buttonand follow any additional instructions displayed on the screen.
After your computer restarts, you will be greeted with the Grubloader. The default OS loaded will be PCLinuxOS. To change whichOS is loaded use the up and down arrows to select the desired OSand than press the enter/return key. This will then boot into the OSyou selected.



Commentary

by an Anonymous Volunteer
The Internet is notorious for being extremely amorphous,transitioning from one definitive technology to another. We'vewitnessed its transformation in its various forums and services.During the later part of the last millennium, a giant grew and built akingdom; and towards the turn, a (community) challenge washeralded throughout the kingdom. Lately, this challenge is gainingmomentum as the giant acknowledges the threat of the community.
I am not a soothsayer who could foretell what will happen after thebattle, and I am not going to make presumptions. I've been wrongquite a few times, though I've made a few logical bulls eyes as well. Iam one who would not publicly make a statement on baselessaudacity.
However, we all notice that there are exciting things happening thesedays: the Novell and the Xandros pact with Microsoft; the “patentinfringements” of Linux; Dell selling Ubuntu machines; PCLinuxOSoutranking Ubuntu on the 7 and 30 days page hits at Distrowatch.These are enchanting and unprecedented times in our history. Moreso, there is a shift, and I am not referring to the migration ofWindows users to GNU/Linux. I am talking FLOSS.
Let's try to make one sensible analysis of this. We can agree that theInternet has become the most important feature in any personalcomputer. PCs request web pages; servers send the code; PCs renderthe pages. It's the same with all other information and services.Content Management Systems (CMS), from blogs to media, such asmusic, videos and photos, often work on the same concept. The PCsare the walls that the echo bounces back from.
There was a time when server stacks were considered as the mainavenue for transversing the information highway. GNU/Linux andMacOS users have full featured servers hidden behind all the glossy,shiny desktops. Windows users seem to be getting the backhand ofthings as they struggle with vulnerabilities and security. Even so,Windows clients can also act as servers.
PCs ... yours and mine and the millions (if not billions) of others... aremaking headway in serving information and services on the very samehighway once owned by a few giants. Is this good, or is this bad?
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Change is inevitable. A sizable fraction of PC owners find themselveswith reasonably fast home connections on top of these hiddenservers on their OSes with enough power and features to get the jobdone. They are beginning to realize that there is no point in payinghosting companies the few dollars to have their websites hosted; theycan do it themselves. Many will probably read the Linux SAG.However, there will always remain problems, especially in the securitysection, and those little broken things that one has to sift though -volumes of fix it readme files. None of these problems are new. Manyusers can just happily live with them.
I'd like to think this is an open door for FLOSS if adequateunderstanding is acquired by the users. A majority are easy to installthrough GUI interfaces, and best of all, owners can exercise theirright to the freedom that accompanies these softwares.
The often misunderstood "alternative" operating system and itscommunities of true freedom fighters along with its creative,innovative, inventive arsenal of FLOSS is ready to confront anyGoliaths and, in the common belief, will stand strong as thechampion of all.
There have been many predictions about the future, and I am not theprophet nor the One. I do know one thing though, there is arevolution going on right now between closed and open sourcesoftware. And I have decided on my side. How about you?



How to Copy/Clone User Account in Linux

Found at http://www.ambience.sk/user-account-copy-linux
Task: Copy/clone user account, so that both users have the verysame settings in their user home directory.
Copying a user's home directory (e.g. olduser) to new user (e.g.newuser) is easy:
1. Create new user: adduser newuser

2. Copy all special hidden (dot) files to new user's home directory:
cp --recursive /home/olduser/.[a-zA-Z0-9]* /home/newuser

3. Copy other standard files to new user directory:
cp --recursive /home/olduser/* /home/newuser

4. Set new user's directory and files owner to new user for hidden dotfiles: chown --recursive newuser:users /home/newuser/.*

5. Set new user's directory and files owner to new user for normalfiles: chown --recursive newuser:users /home/newuser/*

You are done. In some cases you may need to change user group(users in this case).
Now logout and try to login as the new user. All the settings for theprograms should be the very same as for the old user. You can forexample compare the settings by running KDE and checking thewallpaper and other settings of the new user. If the copying of theuser folder was successful, everything will look the same.

Advertisement:
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Your Friend, The Alias, Part I

First a little history.
A short while ago, someone in the PCLinuxOS forum was askingabout apps that would allow mounting an ISO image to his desktop.I've used such apps in the past, but recent installations, using thelatest version of my favorite one, (of the two I've used) MountISO, onnewer distro versions throws up errors that the ISO image is notreally an ISO image, or that it is corrupt. The problem seems to bethat the latest version is from Oct. 16, 2005 and needs updating.
The other is a GUI app, AcetoneISO, which will mount variousproprietary Windows burner image formats, as well. It works fairlywell, but requires a multitude of other packages to work.(1) This is allfine and good, if one needs that functionality. However, I do not runWindows, so my only exposure to image files of a Windows typemight be from an occasional download. For those occasional, oddfiles, I still use AcetoneISO, but I find AcetoneISO to be a ratherclumsy way to mount the ISO images I do work with daily. Eachmount requires a root password, and a directory choice, as to wherethe image will be mounted. This gets old rather fast, when one doesthis many times a day, so I created some aliases to do the job for me,without the hassles.
I suggested using this approach, as an alternative to AcetoneISO, inthe forum thread, with instructions on how to do so. KDulcimer, oneof the forum regulars, suggested that this might make a good articlefor PCLinuxOS mag. In further conversation, I wrote:
"I can type 4 letters faster than I can right click the image andnavigate through three layers of menus.
“When file browsing with Konqueror, I usually have the terminalemulator window open, which syncs with the navigation, and have, atpresent 72 aliases for the things I most commonly do. The longestalias is only 6 letters, most are 4, a few are only 3. Some of thealiases are for chains of other aliases that would otherwise require along script, more complicated than I would know how to write. Forinstance, I download an item from Usenet binaries that is in split rarfiles, with par2 volumes for error correction. Both the unrar and par2apps are command line only, and scare off a lot of users. By creatingan alias for each process, and chaining them with other aliases, asingle 5 letter entry, at the prompt, runs the par2 integrity test,
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makes the repair if it is needed, unpacks the rar volumes, and cleansup the directory so that only the unpacked item remains. I don't haveto remember the various commands, arguments, and syntax, foreach app, only the alias. If I forget the correct alias for the process Iwant, typing "alias" gives me the entire list, to remind me."
KDulcimer, responded with:
"Wow. Would you instead consider writing an article about aliases,how to create them, potential purposes, etc? This sounds like neatstuff."
I had already decided that would be the direction to take; Not onearticle, but a series of articles that would each be a "How to achieve adesired outcome using aliases." So as not to overwhelm the newbies,I will take one desired outcome, or a few related and intertwinedoutcomes, per article, and explain in detail why an alias would bedesired, and then the process of creating it, or them. I will create astep by step set of directions, which the reader can implement, whilethey read the article.
There are already plenty of sources for this information, but most useboring examples, appropriate for programmers only, whereby mostnewbies go "deer in the headlights" when reading, and miss theentire point about the usefulness and simplicity of the process. Theyend up with even more fear of the command line than they startedwith. I hope that, by presenting the information in a real worldcontext, with a subject they can directly relate to, explained inlanguage that a normal child can follow, the process will bedemystified, and the fear dispelled.
Borrowing heavily from the forum article, as I already wrote that inmuch the same manner as I intend to follow throughout the series, itwould seem appropriate that the first should be:
HOW TO MOUNT AN ISO IMAGE ON YOUR DESKTOP, AS A
NORMAL USER, USING AN ALIAS

Rules and Definitions:
I will assume the reader is using the KDE desktop, and give directionsbased on that. (For those using Gnome, you will have to find any
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Gnome equivalents, if necessary, or use the KDE tools, where thereare no equivalents.)
If I write something as <something> it means that the readershould substitute the item indicated with that which is appropriate tohim. (I refuse to follow the "politically correct" him/her/self stuffwhen I write. Get over it, life's too short.)
When I say "open kwrite" for editing, if you like something else,substitute that and use what you're comfortable with.
Alt+F2 = Press the Alt and F2 keys at the same time.
<Enter> = Press the Enter key
****** = Root's password
~/ = Your home directory
./ = This directory = PWD = Present Working Directory = Thedirectory which you are now in, that contains the file you wish actionupon.
* = Anything, Whatever = As used here, in the form, *.iso = Any file,by whatever name, that ends with the extension .iso.
FYI: = For Your Information. I will use this to explain what acommand, or a file entry, does, or means.

INSTRUCTIONS:

First set yourself up as a sudoer. Alt+F2 brings up the "RunCommand" box. In the box, type;
kdesu kwrite /etc/sudoers <Enter>

FYI: This asks the system to open the file "/etc/sudoers" withkwrite, with the root permissions needed to write to that file. Anotherbox will open requesting the root password. Enter it.
****** <Enter>
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Read the file, ignore the part that says it MUST be edited with visudo,and in the appropriate section, at the bottom, write;
<yourusername> ALL=(ALL) NOPASSWD: ALL

where you use your own user name in the obvious place. Save thefile, and close kwrite.
FYI: You are now a sudoer, and will not be asked for a rootpassword each time your alias uses sudo to mount, or unmount, anISO image.
Next, create an empty directory on your desktop named "iso", withoutthe quotes. Left click your "home" icon, and from the "View" menuselect "Show Hidden Files". Open the file .bashrc with kwrite, andcopy/paste into it, this line;
test -s ~/.alias && . ~/.alias || true

Save .bashrc, and close kwrite.
FYI: This tells bash, your shell, to test for the presence of a hiddenfile named .alias, in your home folder, and, if it's present, use it'scontents as if it were an integral part of .bashrc.
FYI: The command to mount an ISO image is; "mount -o loop
/path/to/<filename>.iso /path/to/<mountpoint>"where <filename> represents the actual name of the .iso file, and
<mountpoint> is a directory name. Only root can use the mountcommand, hence the use of sudo.
Next, open kwrite, again, to create a new text file, and copy/pastethese lines;
alias imnt='sudo mount -o loop ./*.iso ~/Desktop/iso'
alias umnt='sudo umount ~/Desktop/iso'

and save the file as ~/.alias.
FYI: The name of the file is ".alias" (without the quotes) and it issaved in /home/<yourusername>



FYI: I chose "imnt" as a unique, short form of "iso mount" to aidremembering the alias, it's purpose, and to differentiate it from anyother command or alias. Similarly "umnt" is a unique shortened formof "umount"
FYI: To break down the alias imnt; sudo="as root"; "mount
-o loop"="mount as if it were a block device"; ./="from thisdirectory"; *.iso="any file with the extension .iso";
~/Desktop/iso="to a directory named "iso" located on this usersdesktop"
FYI: To break down the alias umnt; sudo="as root";
umount="unmount"; ~/Desktop/iso="whatever is mounted to adirectory named "iso" located on this users desktop"
You could just copy/paste the lines into .bashrc, but this way youhave a separate .alias file to keep them, and any other aliases youmay wish to add in the future, and don't clutter up .bashrc.
Now to use this, open the Konqueror file browser, and navigate to thedirectory that contains the ISO image you want to mount. From the"Window" menu, choose "Show Terminal Emulator", and simply type,at the prompt;
$ imnt

Your ISO image is now mounted in the "iso" directory on yourdesktop, and you can browse it to your hearts content, and copy filesfrom it to other directories, if you wish. Remember it's a mountedimage, of a read only file system, so you can't copy files to it, onlyfrom it. One caveat to this working is that the ISO image you want tomount must be the only ISO image in the directory. If you have adirectory with a number of ISO images, you must first separate theminto their own private directories, within the main directory.
To unmount the ISO image, from any terminal window type, at theprompt;
$ umnt

Now, if you have followed the instructions, as you were reading this,and if you have actually created and used the aliases to successfully
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mount, and unmount an ISO image, congratulations. Even if you are agreen as grass, newbie, GUI guy/gal, (I know I said I wouldn't do that.Quit your laughing) you've learned how to accomplish a specific,desired, repetitive type task, with a minimum amount of keystrokes,using the dreaded command line, and it didn't even hurt. :)
In this article, I've tried to be a bit overly redundant with thedefinitions, and the FYI explanations, so that even newbies (Are Linuxnewbies really "gnubies"?) who are not used to command lineshortcuts, and structure, will understand that it's just a way to give asimple instruction to the computer. An alias is used to savekeystrokes when entering those instructions. Some of theexplanations of what the syntax means might not be preciselycorrect, but they convey the essence of what one isrequesting/commanding the computer to do, hopefully in a way thatalso conveys why the structure is as it is.
And what, may I rhetorically ask, do we really learn from all this? Analias is a very simple, quick, shortcut used to enter a morecomplicated command. What is it's true value? Efficiency. The longer,and more complicated the command, the more often one needs touse it, the greater the keystroke reduction, the greater the value ofthe alias.
Next time, I'll show you how to create aliases to actually accomplishsome specific useful tasks, and how to join them to accomplishmultiple tasks with a single alias.
Thus ends our lesson for the day.

(1) AcetoneISO2 depends on the following packages :- fuseiso, fuse-utils, libfuse2, mkisofs, libqt4-core, libqt4-gui,konsole, konqueror, kdebase-bin, kdelibs4c2a,libfuse-dev, build-essential, cdrecord, cdrdao, dvd+rw-tools, p7zip-full, gnupg,coreutils, libglib2.0-dev
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